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28-PIN DEMO BOARD USER’S GUIDE

Preface
INTRODUCTION

This chapter contains general information that will be useful to know before using the
28-Pin Demo Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Revision History

DOCUMENT LAYOUT

This document describes how to use the 28-Pin Demo Board as a development tool to
emulate and debug firmware on a target board. The manual layout is as follows:

• Section Chapter 1. “28-Pin Demo Board Overview” – This chapter provides an
overview of the 28-pin Demo Board for Microchip’s 28-pin PIC® Microcontroller
Units (MCU).

• Appendix A. “Hardware Schematics” – Illustrates the 28-Pin Demo Board
hardware schematic diagram, PCB layout and Bill of Materials.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB IDE online help. 
Select the Help menu, and then Topics to open a list of available online help files.
 2006-2015 Microchip Technology Inc.  DS40001301B-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

N‘Rnnnn A number in verilog format, 
where N is the total number of 
digits, R is the radix and n is a 
digit.

4‘b0010, 2‘hF1

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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Preface
WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly.
Sending in the Warranty Registration Card entitles users to receive new product
updates. Interim software releases are available at the Microchip web site.

RECOMMENDED READING

This user’s guide describes how to use 28-Pin Demo Board. Other useful documents
are listed below. The following Microchip documents are available and recommended
as supplemental reference resources.

PIC16F883/884/886/887 (DS40001291)

Consult this document for information regarding the PIC16F883/884/886/887
28/40/44-Pin Enhanced Flash-Based, 8-Bit CMOS Microcontroller.

PICkit™ 3 Microcontroller Programmer User’s Guide (DS52116)

Consult this document for instructions on how to use the PICkit™ 3 In-Circuit
Debugger/Microcontroller Programmer software and hardware.

MPLAB® ICD User’s Guide (DS51184)

Consult this document for more information pertaining to the features and functions of
the MPLAB In-Circuit Debugger (ICD) software.

MPLAB® X IDE User’s Guide (DS50002027)

Consult this document for more information pertaining to the installation and features
of the MPLAB X Integrated Development Environment (IDE) software.

MPLAB® Code Configurator User’s Guide (DS40001725)

Consult this document for instructions on how to use the MPLAB Code Configurator to
generate peripheral driver code.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in
the Readmes subdirectory of the MPLAB X IDE installation directory. The Readme files
contain update information and known issues that may not be included in this user’s
guide.
 2006-2015 Microchip Technology Inc.  DS40001301B-page 7



28-Pin Demo Board User’s Guide
THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

• Product Support – Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers, assemblers, linkers
and other language tools. These include all MPLAB C compilers; all MPLAB
assemblers (including MPASM assembler); all MPLAB linkers (including MPLINK
object linker); and all MPLAB librarians (including MPLIB object librarian).

• Emulators – The latest information on Microchip in-circuit emulators.This
includes the MPLAB REAL ICE and MPLAB ICE 2000 in-circuit emulators.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit
debuggers. This includes MPLAB ICD 3 in-circuit debuggers and PICkit 3 debug
express.

• MPLAB IDE – The latest information on Microchip MPLAB IDE, the Windows
Integrated Development Environment for development systems tools. This list is
focused on the MPLAB IDE, MPLAB IDE Project Manager, MPLAB Editor and
MPLAB SIM simulator, as well as general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These include
production programmers such as MPLAB REAL ICE in-circuit emulator, MPLAB
ICD 3 in-circuit debugger and MPLAB PM3 device programmers. Also included
are non-production development programmers such as PICSTART Plus and
PICkit 2 and 3.
DS40001301B-page 8   2006-2015 Microchip Technology Inc.
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Preface
CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at

http://www.microchip.com/support.

REVISION HISTORY

Revision A (October 2006)

• Initial Release of this Document.

Revision B (April 2015)

• Updated for PICkit™ 3, MPLAB® X IDE, XC8 compiler and MPLAB® Code 
Configurator.
 2006-2015 Microchip Technology Inc.  DS40001301B-page 9
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Chapter 1.  28-Pin Demo Board Overview
1.1 INTRODUCTION

The  28-Pin Demo Board is a small and simple demonstration PCB for Microchip’s
28-pin Dual Inline Package (DIP) PIC® Microcontroller Units (MCUs). It is populated
with a PIC16F886 MCU, four LEDs, a push button and a potentiometer. The demo
board has several test points to access the I/O pins of the MCU and a prototyping area.
The MCU can be programmed with the PICkit™ 3 Microcontroller Programmer or the
MPLAB® ICD 3 using the RJ-11 to 6-pin inline adapter (AC164110).

1.2 HIGHLIGHTS

This chapter discusses:

•  28-Pin Demo Board Supported Devices

• The  28-Pin Demo Board Overview

• Running the Default Demonstration

1.3  28-PIN DEMO BOARD SUPPORTED DEVICES

The  28-Pin Demo Board can be used with virtually any 28-pin Dual Inline Package
(DIP) PIC MCU. The assembled  28-Pin Demo Board is populated with a
PIC16F886-I/P microcontroller.

Additional  28-Pin Demo Boards can be ordered from Microchip Technology or
distributors via the part number DM164120-3. It comes with one assembled demo
board, two blank  28-Pin Demo Boards and samples of PIC16F1938 and
PIC18F26K22. The blank demo board can be used for evaluating or prototyping circuits
using any of the PIC10F, PIC12F, PIC16F or PIC18F 28-pin devices.

1.4  28-PIN DEMO BOARD OVERVIEW

The  28-Pin Demo Board is populated with a PIC16F886 MCU (U1), four LEDs
(DS1-DS4), a push button (SW1), a 32 kHz crystal (X2) and a potentiometer (RP1). The
board layout is shown in Figure 1-1. The demo board has several test points to access
the I/O pins of the MCU and a prototyping area. The MCU can be programmed with the
PICkit™ 3 via header P1 or the MPLAB® ICD 3 using the RJ-11 to 6-pin inline adapter
(AC164110).
 2006-2015 Microchip Technology Inc.  DS40001301B-page 11
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FIGURE 1-1: 28-PIN DEMO BOARD

1.5 POWERING THE DEMO BOARD

The 28-Pin Demo Board supports the ability to power the board by two options.

1.5.1 External power supply 

The 28-Pin Demo Board can be powered with an external 3 to 5.5V power supply.
Connect a 3 to 5.5V bench power supply to header P2.

1.5.2 Power by Programmer

In order to use the PICkit™ Microcontroller Programmer, connect it to a PC USB port
using the USB cable. Connect the PICkit™ 3 to the ICSP™ connector header P1 on
the 28-pin Demo Board. Open the Project Properties window in the MPLAB® X IDE,
click on the PICkit 3 option and select Options> Categories>Power. Select the
checkbox labeled “Power target circuit from PICkit 3”. Then select 5V for voltage, as
shown in Figure 1-2. Click Apply and then OK. The board can be programmed with
these settings. 

Push Button 

Potentiometer

PICkit™ 3 

LEDs DS1-DS4
 RP1

Programming Header

SW1

PICkit™
Serial Analyzer 

Header

Aux Power
Connector

Crystal 
Mounting Pads

32 kHz Crystal

Prototyping
Area
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28-Pin Demo Board Overview
FIGURE 1-2: POWERING THE DEMO BOARD WITH PICkit™ 3

1.6 THE DEFAULT DEMONSTRATION PROGRAM

The assembled 28-Pin Demo Board populated with a PIC16F886-I/P comes
preprogrammed with a demonstration program. 

A demo program for PIC16F1938 is also available. Driver APIs for the peripherals to
be used in the application can be generated automatically using the Microchip Code
Configurator (MCC) for the latest 8-bit PIC microcontrollers.

The Demo Board will blink the LEDs in the Reset pattern. The Reset pattern consists
of three different LED blink patterns. During the first pattern, the LEDs will “ping-pong”
(LED1, 2, 3 and 4, then LED 4, 3, 2 and 1). Then, the LEDs will blink ON and OFF in
unison. In the third pattern, the LEDs will perform the ADC, where values 0x0A, 0x0D
and 0x0C will be displayed in sequence followed by the Most Significant four bits of the
ADC result measuring channel 1, which is the on-board potentiometer.

 

Note: Driver APIs for PIC16F1938 in the demo program are generated using 
MCC. For details about the Microchip Code Configurator (MCC) go to 
http://www.microchip.com/pagehandler/en_us/devtools/code_configurator.
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Appendix A. Hardware Schematics
A.1 INTRODUCTION

This appendix contains the 28-Pin Demo Board schematic, PCB layout and Bill of 
Materials.

FIGURE A-1: SCHEMATIC DIAGRAM
 2006-2015 Microchip Technology Inc.  DS40001301B-page 15
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FIGURE A-2: SILKSCREEN

FIGURE A-3: TOP COPPER
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Hardware Schematics
FIGURE A-4: BOTTOM COPPER

TABLE A-1: BILL OF MATERIALS

Bill of Materials

Designation Qty Description

C1, C2 2 Capacitor, Ceramic, 0.1 F, 5%, X7R

C6, C7 2 Capacitor, Ceramic, 122 pF, 50V, C0G

R3-R6 4 Resistor, 470, 5%, 1/8W

R2, R7 2 Resistor, 1 k, 5%, 1/8W

R1 1 Resistor, 10 k, 5%, 1/8W

R8 1 Resistor 200 k5%, 1/8W

RP1 1 Potentiometer 10 kthumbwheel

DS1-DS4 4 LED, Red T1-3/4

SW1 1 Switch, push button, momentary

U1 – Microcontroller 1 28-pin PIC® MCU

P1, P3 2 Connector, header, right-angle, 6-pin, 0.100” spacing, 0.025”

JP1 1 Connector, header, 2-pin, 0.100” spacing, 0.025” square

Rubber Feet 4 Bumpon square, 0.40 x 0.10, black

X2 1 Crystal, tuning fork, cylinder, 12.5 pF

J1 1 Connector, receptacle 1x14-pin
 2006-2015 Microchip Technology Inc.  DS40001301B-page 17
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